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What is MindManager Server? 

MindManager Server enhances Microsoft SharePoint, delivering a powerful collaborative work solution that gives 
people the ability to access SharePoint content, manage SharePoint tasks, and work together more effectively on 
projects — all through an intuitive visual framework. MindManager’s interactive maps help people get on the same 
page and stay in sync. 

MindManager Server lets you: 

 Create new maps from SharePoint document libraries. 

 View and edit maps from within SharePoint using your browser or using MindManager for Windows. 

 Create task dashboards on maps by including SharePoint Linker topics that search for matching tasks and 
display them as dynamically linked SharePoint Task topics. 

 Create new SharePoint tasks directly from the map. 

 Use the Mindjet Viewer Web Part to display interactive maps on SharePoint pages. 
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Create a map in 7 easy steps 

Here's how to begin creating a map using MindManager Server right away. 

 Begin a new map: 

On the document library's ribbon, on the Library Tools Documents tab, click New mmap file. 

Enter the map's name, choose a template, and then click OK. 

The new map will open in the MindManager mapping window where you can add topics and other content. 

  

 

  

 

 Enter your main idea: 

In the mapping window, the Central topic is already selected. 

Type the main idea or theme of your map and press ENTER. 

  

   Add supporting ideas: 

To add a main topic press ENTER, type the topic text, and press ENTER. 

To add another main topic, press ENTER again. 

To add a subtopic, press INSERT. 
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   Add other map elements: 

The Home and Insert tabs on the mapping window Ribbon contain commands for adding more map and topic 

elements such as: 

Floating topics   Callouts    Relationships 

Boundaries     Hyperlinks 

Attachments   Notes   Images 

SharePoint task dashboards 

SharePoint Task topics 

 Code topics with visual information: 

Select a topic, and then use commands on the Ribbon's Insert tab to apply Markers ( Icons and  textual Tags ). 

If your current topic is a task, you can apply Priority and Progress icons from the ribbon's Home tab, or click 
Task Info to open the Task Info pane where you can fully define the task's attributes. Resources can be 

assigned from your list of SharePoint users. 

NOTE: When you change the Task Info on a SharePoint Task topic  , the properties of the 

related SharePoint task are also updated. For more information see Edit linked SharePoint tasks. You 
can also send a topic from your map to create a new SharePoint task. 
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  Format the map: 

Select one or more topics that you want to format. 
(To select multiple topics, hold CTRL and click on topics, or drag the selection rectangle.) 

You'll find commands on the Home tab for changing the font used for topic text and the topic's appearance. 

Additional formatting options can be found on the Design tab. Use the Growth and Topic Lines options to 

change the map layout. 

  

Save your changes 

When you finish editing the map, save it to commit your changes. 

Click File, and then click Save to save your changes. Use the Secure Save mode for extra data security. 

When you are finished with the map, you can use commands in the File menu to Close the map and return to 

document library page. 

MindManager Server will notify you if any changes have not been saved when you leave the mapping window. 

    

 

 

See also: 

Mapping in MindManager Server 
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Creating and editing maps 

Create a new Map 

You can create a new map from any documents library (such as Shared Documents). 

NOTE: Your ability to create new maps is controlled by your permissions in SharePoint. 

1. Open the documents library. 

2. On the library's Documents tab, click New mmap file. 

 

 

3. Enter the name for the map you want to create, choose a map template, and then click OK. 

The new map opens in MindManager Server , where you can add content. 

HINT: If you already have maps that you have created in MindManager on your desktop, you can upload 

these using the SharePoint Upload Document command, and then view and edit them in MindManager 
Server. 

See also: 

Mapping in MindManager Server 

View or edit a map in the browser 

You can view or edit your map in the browser using the built-in MindManager Server mapping commands. 

NOTES: 

    Your ability to open and edit maps is controlled by your permissions in SharePoint. 
     If another user has the map checked out you cannot edit it. 

What do you want to do? 

 View a map in the browser 

 Edit a map in the browser 

  

View a map in the browser 

To view a map (open it in Read-only mode) in MindManager: 

 Point to the map name in the document list, click the down arrow, and then click View in Browser. 

The map will open in MindManager Server in Read-only mode. You'll see the Read Only indicator at the upper-left. 

  You can use the commands on the ribbon to view the map, but you cannot edit it. 

To switch to editing mode: 

 On the MindManager Server View tab, click Edit in Browser. 
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Top of Page 

Edit a map in the browser 

HINT: To prevent others from making changes to the map at the same time, you can use the SharePoint 

commands to check it out. You are not required to check out the map before editing, unless this setting is 
enabled in your SharePoint environment. 

To open a map for editing in the browser: 

 Point to the map name in the document list, click the down arrow, and then click Edit in Browser. 

The map will open in MindManager for editing. 

See also: 

Mapping in MindManager Server 

Edit a map in MindManager desktop 

Mapping in MindManager Server 

Map topics and elements 

  

Topics 

Use commands on the Ribbon's Home tab to add basic map elements. when a new topic appears, it is 

automatically selected so you can enter its text. 

 

Central topic 

The main theme or title of your map. 

 Always present when you start a map. 

 

Main topics 

The major ideas that make up the theme. 

 Select the central topic (or no topic). 

 Click Topic, or press ENTER. 

 

Details about main topics. 

Select a topic. 
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Topics and 
Subtopics 

 Click Topic or press ENTER to create a topic at the same level. 

 Click Subtopic or press INSERT to create a topic at the next level. 

 

Callouts 

  

Additional information for a specific topic, relationship, or summary information for a 
boundary. 

 Select a topic, relationship, or boundary. 

 Click Callout or press CTRL+SHIFT+ENTER. 

 Enter your text when the callout appears. 

 

Floating topics 

Auxiliary information or text. 

 Click a location on the map background. 

 Type the topic text. 

More elements 

Use commands on the Ribbon's Home or Insert tabs to add other topic elements. 

 

Topic Notes 

For more extensive, detailed information.   

 Select a topic and click Notes. 

 Enter the text in the Notes window that appears at the bottom of the screen. 

 Use the commands that appear to the left to format or add hyperlinks within 
the note. 

 

Attachments 

To attach documents to topics and embed them in the map file.   

 Select a topic and click Attachment. 

 Select the file you want to upload and attach to the map. You can add multiple 
attachments to a single topic. 

 Point to the attachment icon to see what is attached; click an attachment name 
to open it. 

 

Hyperlinks 

To point to other locations.  

 Select a topic and click Hyperlink. 

 Enter the URL in the dialog. 
You can add multiple hyperlinks to a single topic. 

 Click the hyperlink icon to see the links for the topic; click a link to jump to that 
destination. 

 

Images 

For visual interest. 

 Select a topic and click Image. 

 Select the image you want to add to the topic. 

 Use the Align Image command on the Design tab to adjust its placement 

within the topic. 
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Boundaries 

For grouping or summarizing topics. 

 Select a topic (the boundary will surround or summarize it and all its 
subtopics). 

 Click Boundary or press CTRL+SHIFT+B, or use the pull-down to select a 

specific boundary type. 

 

Relationships 

For showing connections between topics 

 Click Relationship. 

 Click the first topic, and then the second. 

You can add even more information to your map by including Task Info, coding topics with Markers, adding 
SharePoint Linker topics, and using formatting to highlight or categorize topics. 

See also: 

Mapping in MindManager Server 

Add and edit topics 

You build a map by adding topics, and then organizing them into a useful hierarchy. 

What do you want to do? 

 Add topics 

 Select topics 

 Edit topics 

 Move and copy topics 

 Delete topics 
  

Add topics 

Central topic 

When you start a new map the central topic appears with placeholder text. 

 Click to select the central topic, and type your map’s theme or title. 

 Press ENTER when you are finished. 

Other topics 

You can add topics, subtopics, floating topics, and callouts using the keyboard, or by clicking commands on the 
Home tab on the Mapping window's Ribbon. Select a topic, then: 

To add … Windows press … Mac press … Or click ... 

Topic at the 
same level 

ENTER RETURN Topic 

Subtopic INSERT 

CTRL+ENTER 

  

+RETURN 

CONTROL+RETURN 

Subtopic 

Callout CTRL+SHIFT+ENTER +SHIFT+RETURN Callout 



MindManager Server User Guide 

9 

CONTROL+SHIFT+RETURN 

Floating topic*    - - - Floating Topic 

* You do not have to select a topic to add a floating topic. 

You can also  add topics by right-clicking on a topic or on the map background. 

HINT: See Keyboard Shortcuts for additional information. 

Enter topic text 

New topics appear with placeholder text. 

 While the topic is still selected, simply type to enter your own topic text. 

 For a multi-line topic, press SHIFT+ENTER (Mac: SHIFT+RETURN) where you want a line break. 

HINT: Other ways to create new topics are to copy topics within the map, or to add SharePoint Linker topics 

with links to SharePoint tasks. 

Once you've added a topic you can go back and edit its text at any time. To make a topic stand out you can format it 
with text and fill colors, or use a distinctive topic shape. 

Top of Page 

Select topics 

Select a single topic or object 

 Click the topic or object. A highlight appears to show that it is selected.  

Select multiple topics and objects 

 Hold down the CTRL key (Mac:  key) and click to select or de-select them. 

 Hold down the SHIFT key and use the arrow keys to select additional topics. 

 Press CTRL + A (Mac: +A) to select all the topics and elements on the map. 

HINT: See Keyboard Shortcuts for additional information. 

Select all topics within a particular area on the map 

 Click and drag a rectangle. All topics that the 
rectangle touches will be selected. 

 

De-select topics 

 To de-select individual topics press CTRL (Mac:  key) and click them. 

 To de-select all topics, click the map background. 
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Top of Page 

Edit topics 

Replace a topic’s text 

 Select the topic and type the new text. 

You can also use the Find & Replace feature to replace text in multiple topics. 

Modify a topic’s text 

1. Select the topic. 

2. Click inside the text to start edit mode. 

3. Once you are in edit mode, you can edit the text as you do in most applications. 

HINT: See Keyboard Shortcuts for additional information. 

Multi-line topics 

 To create a multi-line topic, press SHIFT+ENTER (Mac: SHIFT+RETURN) where you want a line break. 

 You can drag the topic's sizing control   , or its left or right edge to control the way the topic text 
wraps. To return the topic to a single line, double-click the topic's left or right edge. 

Top of Page 

Move and copy topics 

Drag and drop topics 

You can move the topics on your map by simply clicking and dragging one or more topics to a new location. 

 

Select the topic(s) and drag them to a new position on the map. A red visual 
cue appears showing where the topic(s) will be added. 

HINT: Hold SHIFT as you drag to prevent the topic from attaching 

to other topics. 

Cut, Copy, and Paste topics 

Do one of the following: 

 Select a topic, and then click Cut or Copy on the Ribbon's Home tab. 

 Right-click a topic, and then click Cut or Copy. 

 Select a topic, and then press CTRL+X or CTRL+C (Mac: +X or +C). 

Then, do one of the following: 

 Select another topic, or click the map background, and then click Paste on the Ribbon's Home tab. 

 Right-click another topic, and then click Paste Topic. 

 Select another topic, or click the map background, and then press CTRL+ V (Mac: +V). 

The cut or copied topic will be pasted as a subtopic of the selected topic. 

HINT: You can also use the right-click commands to create links between map topics. 
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Delete topics 

To delete topics, do any of the following: 

 Select one or more topics, and then press DEL (Mac: DELETE). 

 Select one or more topics, and then click Delete on the Ribbon's Home tab. 

 Right-click a topic, and then click Delete Topic. 

HINT: If you delete a topic in error you can click Undo  on the top toolbar. 

To remove a topic but keep its sub-topics, do one of the following: 

 Right-click the topic, and then click Remove Topic. 

 Select the topic, and then press CTRL+SHIFT+DEL. 

See also: 

Add other information 

Add visual elements 

Code topics with markers 

Format a map 

View and navigate 

The MindManager Server mapping window provides you with a variety of commands to help you move through and 
view your map. Many commands also have keyboard shortcuts. 

What do you want to do? 

 Minimize the ribbon 

 Navigate 

 Pan and zoom 

 Change the level of detail 

 Filter the map 

 Find and replace text 
  

Minimize the ribbon 

You can minimize the ribbon to expand the mapping area and see more of your map. 

 To minimize the MindManager Server ribbon, click the Minimize Ribbon  button at upper-right. 

 To see the ribbon again, click a tab on the ribbon, or click the Restore Ribbon    button. 

Top of Page 

Navigate 

You can move between topics using the keyboard: 

 Use the arrow keys (left, right, up, down) to move between topics 

 TAB to move to the next topic. 
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Pan and zoom 

For smaller maps navigation is straightforward when the map is displayed at full size with all topics shown. For 
larger maps you may find it helpful to zoom out, change the level of detail , or focus on a topic to view a specific part 
of the map. 

Panning 

To move the map, use the scroll bars along the map side and bottom, or click and hold on the map background until 

you see the hand cursor   , and drag it . 

HINT: Wheel mouse users can scroll using the wheel. 

To center the map, click Center Map on the ribbon's View tab. 

Zooming 

To adjust the Zoom factor enter a factor on the ribbon's View tab. 

To fit the map to the window, click Fit Map ribbon's View tab, or right-click the map background, and then click Fit 
Map. 

Top of Page 

Change the level of detail 

 

You can change the level of detail displayed for individual topic trees as well as for the entire map. 

Collapse and expand topics 

You can collapse or expand topics interactively using the icons that appear on each topic with subtopics. 

 Click  to expand the topic (see its subtopics) 

 Click  to collapse the topic (hide its subtopics). 

Change the level of Detail 

1. Select topics: 

 To change the level of detail for the whole map select the central topic or select nothing (click the 
map background). 

 To change the level of detail for a topic tree, select the tree's parent topic. 

2. Choose the level of detail: 

 On the ribbon's View tab, click the Expand pull-down to choose the level of detail. 
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 Click the top part of the button to progress through the detail levels for the map or branch. 

 Click Next Level to expand the map or topic one level at a time. 

Focus on topic 

The Focus on Topic command shows the selected topic centered and expanded to an optimum level. Its sibling 
topics and other main topics are collapsed. 

1. Select the topic. 

2. On the View tab, click Focus on Topic. 

Top of Page 

Filter the map 

NOTE: you cannot filter the map in Read-only mode. 

 

You can use the Filter command to hide or show selected topics on your map. The Central Topic and the parents of 
displayed topics are always shown. 

1. Select one or more topics. 

2. On the View tab on the ribbon, click Show Selected Topic or Hide Selected Topic . 

HINT: Filtering is cumulative: To filter the map further, repeat the Filter process again. 

To remove the filter, click Remove Filter. 

Top of Page 

Find and replace text 

To quickly find some text in your map: 

 Enter it in the Find box in the upper-right corner of the mapping window, and then press ENTER or 

RETURN. 

 Press ENTER or RETURN again to find the next occurrence. The command searches the map in a 

clockwise direction, starting with the topic at upper-right. 

You can find and optionally replace text in your map topics using the Find and Replace options in the Task Pane. 

1. Click  to open the Task Pane. 

2. Enter the text to search for, then click Next to search in a clockwise direction or Previous to search counter-

clockwise . The first topic with matching text will be selected. 

3. Then, do one of the following: 
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 To find the next matching topic (clockwise) click Next . 

 To find the previous matching topic click Previous . 

 To replace the text with new text, enter the new text in the Replace With field. 
Click Replace  to change the text in the selected topic, or click Replace All to change all matching 
text in the map to the new text. 

The Find command only searches through topic text, Tags, and task info Resources. It does not search text 

in topic Notes or in Attachments. 
 
The Replace command can only be used to replace topic text. You cannot use this command in Read-only 
mode. 

See also: 

Add and edit topics 

Add other information 

Map topics are most easily read and understood when their text is brief. You can include more information on your 
map by using a variety of topic elements to contain that information without detracting from the map's clarity. 

What do you want to learn about? 

 Notes 

 Hyperlinks 

 Attachments 

 Task info 
  

Notes 

Map topics are most readable when they are kept short. For topics that need more 
detail, you can add topic notes to include more information. Topic notes can be 
formatted, and can include hyperlinks and graphics. 

 

Enter Notes text 

1. Select the topic. 

2. On the Ribbon's Home tab, click Notes. 

HINT: Right-click a topic and then click Notes. 

3. Enter the note in the notes pane below the map window. (You may need to drag the splitter up to see the 
window.) You can type the text or copy and paste it from another document. 

4. Format the note as you desire by selecting text and using the formatting buttons in the notes pane. 

A Notes icon  appears on the topic to show that it contains a note. Point to this icon to see a summary of the 
note. The Notes pane will open, displaying the text whenever you select the topic. 

Include a hyperlink in Notes 

1. Select some text in the Notes pane. 

2. Enter the link destination in the Notes pane link location box after http://. 

For example: www.mindjet.com. 

3. The text will automatically be formatted to show that it contains a link. 

To remove the link, select the text again and delete the address from the link location box. 
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Hyperlinks 

You can add a link to a topic that points to a web address or to a document. You can 
also create links that point to other topics in the current map. You can add multiple 
links to a single topic. 

 

Create a hyperlink to a url or document 

If you are linking to a document, you should first copy the url of the link's target: Right-click the document name in its 
document library, and then, in the shortcut menu, click Copy Shortcut. Now, open the map and proceed with the 

following steps. 

1. Select a topic on the map. 

2. On the Ribbon's Home or Insert tab, click Hyperlink. 

HINT: Right-click a topic, then click Add Hyperlink. 

3. In the dialog, enter or paste  a link destination. You can enter a link with an http:// address. 

4. Click Add. 

5. You can continue to add more hyperlinks. The list of hyperlinks that will be added appears with buttons for 

editing  or removing  individual links. 

6. When you are ready to add the links to the map, click Save. 

You'll see a link icon   appear on the topic. Point to the icon to see the link destination. If the topic contains 
multiple links, click the icon to see the list of links. 

When you click this icon (for a single link) or the link in the list (for multiple hyperlinks), the link is activated, and the 
web page or document opens. 

NOTE: Other users must have access to the document in order to activate a document link. 

Create a link to a topic 

You can create a link to a topic on the current map using right-click commands. 

1. Right-click the topic you want to link to (the target topic), and then click Copy as Hyperlink. 

2. Right-click the topic where you want to create the link, and then click Paste as Hyperlink. 

You'll see a link icon  appear on the topic. When you click this icon, the link is activated and the target topic is 
selected. 

Edit or remove hyperlinks 

1. Right-click the hyperlink icon on the topic, and then click Manage Hyperlinks. 

2. In the dialog, click the edit  or delete    buttons to modify or remove a link. 

3. When you are finished, click Save. 

Top of Page 

Attachments 

You can attach a document to a topic, such as a Word document, a spreadsheet, a 
text file or other document type. The attached document becomes part of the map, 
independent from the original source document, and is saved with the map. You can 
add more than one attachment to a topic. 

.  
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Add an attachment 

1. Select a topic. 

2. On the Ribbon's Home or Insert tab, click Attachment. 

HINT: Right-click a topic, then click Add Attachment. 

3. In the dialog select a document. 

You'll see an attachment icon  appear on the topic. 

View an attachment 

 

When you point to the attachment  icon you will see the list of 
attachments. 

When you click the icon, the attachment list opens. Click on the 
attachment that you want to view. It will download and open in its native 
application. 

In order for you to open an attachment, the attachment's document type must be associated with an application on 
your system. 

NOTE: You can only view, but not edit attachments with MindManager Server. If you edit the attachment 

while you have it open your changes are not saved back to the map. 

Remove an attachment 

1. Right-click the attachment icon on the topic and then click Delete Attachment. 

2. In the list that appears, click the attachment you want to delete from the topic. 

Top of Page 

Task info   

Task information is shown by marker icons (for priority and % complete) and as 
text displayed in a small window below the topic (for Resources, Duration, and 
Start and Due dates). 

 

Add task info to a topic* 

1. Select a topic. 

2. On the Ribbon's Home tab, select the Priority and Progress icons you want to use. 

3. To provide additional details, click Task Info and use the Task Info pane options to select and enter the 

information for the topic. Resources can be assigned from your list of SharePoint users. 

HINT: The Show Task Info and Show year in dates options apply to all task info on the map. 

Change or remove a topic's task info* 

To change a topic's Task Info: 

 Right-click the Task Info text, and then click Change. 

You can remove the textual task info displayed below a topic directly. (Task info icons can be removed in the same 
way as other icon markers.) 

 Right-click the Task Info text, and then click Remove. 
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* NOTE: For more information on editing Task Info on linked SharePoint Task topics (displaying the 

SharePoint Task icon   ) see Edit linked SharePoint tasks. 

See also: 

Create SharePoint task dashboards 

Send or create new tasks 

Code topics with markers 

Add visual elements 

Visual elements can be used to indicate connections (relationships) or groupings (boundaries), or simply to make 
topics more memorable (images). 

What do you want to learn about? 

 Relationships 

 Boundaries 

 Images 
  

Relationships    

Sometimes a relationship exists between two (or more) topics, and you want to 
illustrate this on your map. You can add a relationship line that connects two topics, 
and label it if you wish. You can change the look of the relationship using the Task 
Pane's Format settings. 

 

Add a relationship 

1. On the Ribbon's Insert tab, click Relationship. 

HINT: Right-click a topic, and then click Insert Relationship. 

2.  When the cursor changes to the Relationship cursor, click the first topic, and then click the second 
topic. 

The relationship line appears connecting the two topics. The topics will remain connected even if they are moved. If 
you move one or both of the topics connected by a relationship, the line will automatically adjust. 

  

Modify and format the relationship 

 

When you select a relationship, handles appear so you can re-shape it or change its 
connection point. 
  

Change the shape of the line 

 Select the relationship, then drag the handles . 

Relationship lines follow an optimal path by default because their Auto Layout attribute is enabled. If you re-shape 
the line, the Auto Layout option is automatically disabled. If you want the line to return to its optimal path you can re-
enable the Auto Layout option in the right-click shortcut menu. 



Creating and editing maps 

18 

Connect to a different topic 

 Select the relationship then drag the connection handle   to another topic. 

Format the line's style and color 

1. Select the relationship line(s). 

2. Use the commands on the Ribbon's Home tab to change its line style and color. 

3. For more options, click  to open the Task Pane, and use the Format group settings. 

Add a callout (label) to the relationship 

1. Select the Relationship. 

2. On the Ribbon's Home tab, click Callout. 

HINT: Right-click the relationship line, and then click Insert Callout. 

3. When the generic callout appears enter your text. 

4. Format the callout using the settings on the Ribbon's Home and Design tabs. 

Remove a relationship 

 Select the relationship line, and then click Delete on the Ribbon's Home tab. 

HINT: Right-click the relationship line, and then click Delete Relationship. 

Top of Page 

Boundaries 

Boundaries come in two basic types: grouping boundaries and summary boundaries. 

 

  

 

Grouping boundaries can be used to 

emphasize the relationships between topics 
and subtopics with an outline surrounding an 
area on a map with your choice of line type 
and an optional fill color. 
  

  Summary boundaries can be used to reduce 

a set of subtopics into a single summary topic 
and then allow this topic to grow again. 

Create a boundary 

1. Select the topic whose subtopics you want to group with the boundary. 

2. On the Ribbon's Insert tab, click Boundary. 

HINT: You can add boundaries within boundaries. 

Format, modify, or copy a boundary 

 

When you select a boundary, blue highlighting appears to show that it is selected. 
Then you can change the boundary's formatting. 
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Format a boundary 

1. Select the boundary. 

2. Use commands on the Ribbon's Home and Design tabs to change its line style, fill color, and transparency. 

3. For more options, click  to open the Task Pane, and use the Format group settings. 

 Add a summary topic (callout) to a boundary 

1. Select the boundary. 

2. On the Ribbon's Home tab, click Callout. 

1. HINT: Right-click the boundary and click Insert Callout. 

3. When the generic callout appears enter your text. 

4. Format the callout using the settings on the Ribbon's Home and Design tabs. 

HINT: You can expand the summary topic into a new topic tree by adding subtopics to it. 

Remove a boundary 

 Select the boundary and click Delete  on the Ribbon's Home tab. 

HINT: Right-click the boundary and click Delete Boundary. 

Move or copy a boundary 

1. Select the boundary and click Cut or Copy on the Ribbon's Home tab. 

2. Select a topic. The boundary will enclose this topic and its subtopics. 

3. Click Paste on the Ribbon. 

Top of Page 

Images   

You can add images from JPG, GIF, and PNG files to your map. Images 
can be either attached to an existing topic or added to new topics. You can 
add images to topics, subtopics, floating topics, and callouts. 

 

Add an image 

1. Select a topic, or create a new topic, callout, or floating topic. 

2. On the Ribbon's Home tab, click Image. 

1. Right-click a topic then click Add Image. 

3. Choose the image you want to insert on the topic. 

Position the image 

The image placement settings allow you to orient the image relative to the topic text. 

1. Select the topic that contains the image. 

2. On the Ribbon's Design tab, click Align Image, and select the placement you want to use. 

Re-size an image 

1. Select the image inside the topic. 

2. Drag the corner handles  to re-size the image. Hold SHIFT as you drag to change the image's aspect 

ratio. 

To return the image to its original size, right-click the image, and then click Reset Image Size. 
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Remove an image 

 Right-click the image inside the topic, then click Delete Image. 

See also: 

View and navigate 

Format a map 

Code topics with markers 

You can add two types of markers to your maps - icons  and tags - using 
commands on the Ribbon and in the Task Pane. An icon marker is a small 
image  that gives information about a topic in a graphical, easily understood way. 
A tag is a brief notation that gives information by displaying the text below the 
topic. 

 

See all the available markers 

 Click   to open the Task Pane, then open the Map Markers group. 

 Use the and  controls to expand and collapse marker groups. 

Icon markers 

MindManager Server comes with a set of icon markers that you can use for coding your topics. 

Apply icon markers to a topic 

1. Select one or more topics. 

2. On the Ribbon's Insert tab, click Icons and select the icon in the pull-down. 

3. If you don't see the icon you want to use, click Organize Icon Markers to open the Task Pane. In the Task 
Pane Map Markers group, click on a marker in one of the Icon Markers groups. 

You can assign several icons from different groups to a single topic, but you may only use one icon from each 
group. (Markers within the groups are mutually exclusive.) The Symbols group is an exception: You may assign 
more than one marker from this group to a topic. 

Change icon markers on a topic 

1. Select the topic. 

2. Do one of the following: 

 Right-click the icon, and then click Change. In the Task Pane, click on a different icon in the same 
group as the icon you want to change. 

 Click the icon on the topic to cycle through other icons in that group. Press SHIFT and click to cycle 
in reverse. 

Remove icon markers from a topic 

1. Right-click the marker on the topic. 

2. Then do one of the following: 

 Click Remove to remove this single marker from the topic. 

 Click Remove All to remove all the markers from the topic. 

Move or copy icon markers 

 To copy a marker, drag the marker to a different topic. 

 To move it, hold CTRL as you drag it. 
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Tags 

You can create your own groups of tags to use. A group is usually a category or class, and the marker names within 
the group are its sub-categories. 

Example: 

You could create the group  "Sample size" 

with markers named "0-1"  ,   "2-5"  ,   "6-10"  ,   ">10"  . 

These would display beneath the topics as: 

       Sample size: 0-1 

       Sample size 2-5 

... and so on. 

Create a new tag group 

1. In the Task Pane, open the Map Markers group. 

2. Under Tags click Add Tag Group. 

3. Enter the Group name. 

4. Click Add. 

Add tags to a group 

You can add new tags to a new, empty group, or to an existing group. 

1. Right-click the group name in the Task Pane's Map Markers group, and then click New Tag. 

2. Enter the Name for the tag, and then click Add. 

3. Repeat these steps to add more tags. 

Apply tags to a topic 

1. Select one or more topics. 

2. Click on a marker in one of the Tag groups. 

You can assign several tags to a single topic, from one or more groups. (Markers within groups are not mutually 
exclusive.) 

Remove tags from a topic 

 Right-click the tag on the topic, and then click Remove. (This removes all tags.) 

 Select the topic, then click the tag to remove in the Markers pane. 

Rename or remove tags from a group 

1. In the Task Pane, right-click the marker you want to rename or remove. 

2. Click Rename Tag or Delete Tag. 

Rename or remove a tag group 

 In the Task Pane, right-click the group name, and then click Delete Group. 

 In the Task Pane, right-click the group name, click Rename Group, and then enter the new name. Group 

names on the map will update automatically. 

Format a map 

You can format your map with colors and fonts to distinguish topics, change the shape of the connecting lines and 
the type of layout, and apply numbering to topics. 

You can change the format of Boundaries and Relationships using the options in the Task Pane's Format tab. 
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What do you want to do? 

 Format map topics 

 Change the map layout 

 Change the map background color 
  

Format map topics 

1. Select one or more topics. 

2. Select the attributes for the topic and its text on the Ribbon's Home tab. 

3. For more options, click the Design tab. 

HINT: You can also format a portion of the topic text by selecting it and then using the options in the Font 

group. 

Top of Page 

Change the map layout 

1. Select one or more topics. 

2. On the Ribbon's Design tab, select the options for the map layout. 

Growth applies to the current topic and its subtopics. 

Topic Lines applies to the lines from the current topic to its subtopics. You can choose a shape and the 
Line Anchor position (the location of the connecting point of lines from the current topic to its subtopics). 

Top of Page 

Change map background color 

1. Right-click an empty place on the map, and then click Background Color. 

2. Select a color, then click OK. 

Top of Page 

Number topics 

You can number topics with your choice of numbering schemes. Numbering is enabled by selecting a parent topic in 
a topic tree. It is dynamic - if you move or delete a numbered topic the numbering of the tree is automatically 
adjusted. 

1. Select the topic whose subtopics you want to number. 

2. On the Ribbon's Home tab, click Numbering. 

3. Choose the numbering type. 

4. Click Depth, and choose a level. 

Remove numbering 

1. Select the parent of the numbered topics. 

2. On the Ribbon's Home tab, click Numbering, and then click Remove Numbering. 

Save and close a map 

When you are done editing your map, you must save it to commit your changes. 

 Click the File tab, and then click Save. 

 Click Close to return to the document library page. 
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If you have the map checked out, you should check it in so others can see your changes and edit the map. 

If you have SharePoint data saved in a map, and you want to restrict its visibility to users who have permission to 
view it, you can use Secure Save mode. 

Print a map 

You can print the current view of a map from the mapping window. It will print with topics expanded or collapsed, 
hidden or visible, just as you see on your screen. You can choose to print either the whole map or you can click and 
drag to select an area of the map to print. 

1. On the ribbon, click the File tab, and then click Print. 

2. In the Print Preview, choose the options you want to use. 

HINTS: 
Click and drag on the map preview to select a specific area to print. 
The map background is not included by default. Omitting the background can make your map print 
faster, and saves ink. 

3. Click Print. 

4. In the Print dialog, select the printer you want to use, and then click Print. 

Keyboard shortcuts 

You can use these shortcuts in the MindManager Server mapping window. 

NOTE: The availability of these shortcuts will depend on which browser you are using. Some browsers use 

these keystrokes for other functions. 

Function Windows Mac 

Navigating and Viewing     

Scroll map by large steps  PgUp  /  PgDn   

Ctrl+PgUp / Ctrl+PgDn 

 PgUp  /  PgDn 

+PgUp / +PgDn  * 

Scroll map by small steps  Ctrl+Up / Down +Left / Right / Up / Down 

Zoom in  Ctrl+ = Control + = 

Zoom out  Ctrl+ - Control + - 

Fit map to window  Shift+F5 Shift+F5 

Change level of detail  Ctrl+Shift+D Control+Shift+D 

Focus on topic  Shift+F3 Shift+F3 

Find Ctrl + F Control + F 

Open / close Task Pane Ctrl+Shift+T Control+Shift+T  * 

Open  /  close Notes panel Ctrl+Shift+N Control+Shift+N  * 

Inserting topics and objects     

Insert topic Enter Return 

Insert subtopic Insert  or Ctrl+Enter Control + Return  * 

Insert callout Ctrl+Shift+Enter Control + Shift +Return  * 
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Add boundary Ctrl+Shift+B Control+Shift+B  * 

Add hyperlink Ctrl+K Control+K 

Selecting topics     

Select next topic Tab Tab 

Select neighboring topic Arrow keys Arrow keys 

Select a group of topics Shift+Left  / Right / Up / Down Shift+Left  / Right / Up / Down 

Select additional topics Ctrl + click  or  Ctrl + drag   + click  or    + drag 

Select all topics Ctrl + A Control + A  * 

Editing topics     

Cut / Copy / Paste Ctrl+X / C / V IE within text only Control+X / C / V 

Undo / Redo Ctrl+Z / Y Control+Z / Y 

Delete selected topic 
(and its subtopics) 

Del Delete 

Remove selected topic 
(retain subtopics) 

Ctrl+Shift+Delete Control+Shift+Delete  * 

Edit existing topic text F2 F2 

Formatting     

Bold topic text Ctrl+B Control+B 

Italicize topic text Ctrl+I Control+I 

Underline topic text Ctrl+U Control+U 

  *  These commands can be executed using either the command key or the control key. 

Using SharePoint tasks 

Search and link to SharePoint tasks 

You can search for and link to SharePoint tasks that meet specific criteria to create task dashboards on your map. 

You use the Search Tasks command in MindManager Server to create a SharePoint Linker topic, which displays a 
wizard for defining the search criteria. When you finish the wizard, MindManager Server searches for tasks, and 
then displays the SharePoint Linker topic on your map with a subtopic for each matching task. You can refresh the 
topic or the entire map at any time to get up-to-date search results. 

The SharePoint Linker results topics on your map are SharePoint Task topics, dynamically linked to their 
corresponding SharePoint tasks, and you can edit the tasks directly from your map. 

If you want to change the search criteria, use the Edit Search command to update the criteria and repeat the 
search. The new results will be displayed automatically on your map. 

What do you want to do? 

 Add a SharePoint Linker topic to your map 

 Move or copy SharePoint Linker topics 
  



MindManager Server User Guide 

25 

Add a SharePoint Linker topic to your map 

To create a SharePoint Linker topic on your map: 

1. Select a topic. (The SharePoint Linker topic and its results will become subtopics of this topic.) 

2. On the ribbon's Home tab, in the SharePoint group, click Search Tasks. 

3. A wizard appears that lets you specify a site connection and other search criteria. More... 

The first step in every wizard prompts you to choose one or more SharePoint site connections. 

1. Enter a site url (for example: http://project_site/alpha_project/ ) and then click Add. 

Repeat for all the sites you want to search. 

2. Select the sites (or sub-sites) in your list of available sites. A check-mark appears next to 
the sites you have selected. 

3. Click Next. 

On the following screens, use any combination of search criteria: 

 Assigned to yourself (Me), all users (Anyone) or another user identified by their 

name (First Name and Last Name together) or email address.   

Note that selecting Anyone may slow down performance due to the 

possibility of an extremely large result set. 

 SharePoint task due date 

 SharePoint priority (SharePoint has only three priorities). 

 A word (or words) contained in the Title or Description. Separate keywords by 
commas. 

 SharePoint task status field (Any or Not Started or Completed), or select 
Range Between and enter the range for the SharePoint % Complete field. 

4. Click Next to step through the wizard screens, and then click Finish. 

The SharePoint Linker topic   appears on your map, along with a set of subtopics for each matching 

task.  (You'll see a "Loading..." icon   while the search executes.) These subtopics are SharePoint Task topics 

, linked to their corresponding SharePoint tasks.  See an example. 

 

To see up-to-date results at any time, you can refresh the SharePoint Linker topic, or the entire map. 
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You can view the properties for both search topics and results topics in the Task Pane: 

1. Select the SharePoint Linker or SharePoint Task topic on the map. 

2. Click   to open the Task Pane. 

3. In the Task Pane, click Topic Properties. 

If your system can't connect to the SharePoint server (due to an error in the URL or an interrupted connection) the 

SharePoint Linker topic will display an icon   showing that the topic is disconnected. 

If you don't want unauthorized users to see the search results on the map, you can use Secure Save mode. 

Edit the search criteria 

To change the search criteria and see new results: 

 Select the SharePoint Linker topic and then click Edit Search. 

Top of Page 

Move or copy SharePoint Linker topics 

You can move or copy the parent SharePoint Linker topic freely without affecting its functionality. 

If you move or copy one of its subtopics (a results topic),  that topic becomes independent of the SharePoint Linker 
topic but still retains a link to its associated SharePoint task. 

When you refresh the SharePoint Linker topic, a new results topic is added to replace the one you moved. This can 
create duplicate items on your map. 

For more information about editing results topics, see Edit linked SharePoint tasks. 

  

See also: 

Edit linked SharePoint tasks 

Refresh linked SharePoint task topics 

Use Secure Save mode 

Send or create new tasks 

You can send a topic from your map to a task list of the current SharePoint site to create a new SharePoint task. 
Once sent, the map topic becomes a SharePoint Task topic linked to its associated SharePoint task, so you can edit 
the task properties either directly from your map or in the SharePoint task list. 

You can also create new SharePoint tasks directly from the MindManager Server mapping window ribbon. If the 
new task matches the search criteria for any SharePoint Linker topics on your map, a results topic will be displayed 
for it when you refresh the map. 

If you don't want unauthorized users to see the data for SharePoint Task topics on the map, you can use Secure 
Save mode. 

What do you want to do? 

 Send a task to SharePoint 

 Create a new SharePoint task 
  

Send a task to SharePoint 

You can send a topic from your map to the SharePoint task list to create a new task. The topic text becomes the 
task name - all other task info is optional and will be stored as Properties of the new SharePoint tasks. 
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MindManager Server Topic SharePoint task property 

Topic text Title 

Priority* Priority (1-3 only) 

Start Start Date 

Due Due Date 

Complete % Complete 

Resource Assigned To 

Topic Notes Description 

1. Select one or more topics on your map. 

2. On the Home tab, in the SharePoint group, click Send Tasks. 

3. In the dialog that appears, choose which topics to send, and specify the SharePoint site address and the 
target list for the new tasks. 

 You can choose from sites you have used previously, or enter a new site address, and then press 

ENTER. 

 You can then choose from all the task lists on that site where you have write access. 

4. Click Send. 

You'll see a message that tells you how many tasks were created, with a link to the list where they were added. 
You'll also be informed if some tasks could not be created. Click More Info for an explanation of any errors. 

Each topic that was successfully sent becomes a SharePoint Task topic indicated by the SharePoint linked task icon 

. See an example. 

 

The task is now linked to its associated SharePoint task, so you can edit the task's properties either directly from 
your map or in the SharePoint task list. 

You can view the task's properties in the MindManager Server Task Pane: 

1. Select the SharePoint Task topic on the map. 

2. Click   to open the Task Pane. 
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3. In the Task Pane, click Topic Properties. 

Top of Page 

Create a new SharePoint task 

You can create a new SharePoint task from the MindManager Server ribbon: 

1. On the Home tab, click Create Task. 

2. The page for creating the task in your default SharePoint task list opens in a new browser tab or window. 
(You can navigate to a different list to create the task in a different location.) 

3. Enter the task properties, and then click Save. 

When you have finished creating the task, you can close the browser tab or window. If your map contains 
SharePoint Linker topics you can refresh the map to update them: If the new task meets the search criteria for any 
of these topics, a results topic linked to the new task will be added to your map. 

  

See also: 

Use SharePoint task dashboards 

Edit linked SharePoint tasks 

Use Secure Save mode 

  

Edit linked SharePoint tasks 

SharePoint Task topics are linked to their associated SharePoint tasks. They feature two-way communication with 
their corresponding SharePoint tasks, so you can edit the tasks either directly from your map (by changing the 
topic's Task Info), or from the SharePoint task list (by editing the SharePoint task's properties). 

SharePoint Task topics can be added to your map in two ways: 

1. By creating a task dashboard using the Search Tasks command to conduct a search. The search info is 

stored in a SharePoint Linker topic  , with the search results as subtopics that are SharePoint Task 

topics . See an example. 
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2. By using the Send Task command to send a topic to a SharePoint task list and create a new task. The topic 

becomes a SharePoint Task topic  linked to its associated SharePoint task.  See an example. 

 

If you edit a SharePoint Task topic, the corresponding SharePoint task is updated immediately. 

If you edit a SharePoint task from its task list, any SharePoint Task topics are updated on refresh. 

HINT: You can also edit a SharePoint search topic to change the criteria used for the search using the Edit 

Search command on the ribbon. 

What do you want to do? 

 Edit a linked SharePoint task from your map 

 Edit a linked SharePoint task from its task list 
  

Edit a linked SharePoint task from your map 

 

 Enter new topic text to change the SharePoint task's Title. 

 Click the Notes icon   on the topic to change the SharePoint task's Description, or click the Notes button 

on the Insert tab to add one.. 

 Use the Task Info pane to change or add other SharePoint task properties: On the Home tab, click Task 
Info to open the pane, and then define any of these properties. 
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MindManager Server Task Info SharePoint task property 

Priority* Priority (1-3 only) 

Start Start Date 

Due Due Date 

Complete % Complete 

Resource Assigned To 

 Duration and Milestone are ignored by SharePoint. 

 Note that you can also change the Priority or Progress markers directly on the topic. 

The changes you make on the map will immediately change the SharePoint task's properties. 

Top of Page 

Edit a linked SharePoint task from its task list 

Do one of the following: 

 Open the task from the map by clicking the SharePoint Task topic's hyperlink . The task will open in a 
new window for editing. When you save the task, refresh the map to update the topic with the new task 
properties. 

 Edit the task directly from its task list. Map topics linked to this task will be updated when they are refreshed. 

Refresh linked SharePoint task topics 

SharePoint Linker topics and individual linked SharePoint Task topics are refreshed automatically when you open 
the map, but you can see up-to-date results at any time by refreshing the entire map. If you have edited a 
SharePoint task from its task list, you must refresh the map to see your changes. 

You can also refresh SharePoint Linker topics individually to see updated search results. 

When the map is refreshed, it will display search results for SharePoint Linker topics and the data for linked 
SharePoint Task topics based on your SharePoint permissions. 

Refresh the entire map 

To update the search results for all SharePoint Linker topics and the properties for all SharePoint Task topics on a 
map, you can refresh the entire map: 

 On the Home tab, click Global Refresh. If your map is large, this may take some time. 

Each SharePoint Linker topic's search is run and the updated results are added to the map. For individual 
SharePoint task topics the properties are retrieved from the associated SharePoint tasks. 

Refresh individual SharePoint Linker topic results 

To see updated results for a specific SharePoint Linker topic: 

 Click Refresh  on the parent SharePoint Linker topic. 

Changes to SharePoint Linker topics on refresh 

On SharePoint Linker topics, results subtopics may be removed (if a task no longer meets the criteria) or added (if a 
task now meets the criteria). 

If you have added subtopics to any results topics, they will be removed on refresh if their parent is removed. 
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See also: 

Use SharePoint task dashboards 

Send or create new tasks 

Edit linked SharePoint tasks 

Use Secure Save mode 

If you have SharePoint data saved in a map, and you want to restrict its visibility to users who have permission to 
view it, you can use Secure Save mode. When Secure Save Mode is enabled for a map, SharePoint data is 
protected by never saving it in the map. Maps that are not saved in Secure Save mode may briefly display data to 
unauthorized users. 

To enable Secure Save mode for a map: 

 On the File tab, click Secure Save to toggle the mode. This mode is specific to the current map, and 

remains at the current setting until you change it. 

When you save a map with Secure Save enabled: 

SharePoint Linker results topics are removed from the map while the parent topic (that contains the search criteria) 
remains in the map. 

Individual linked SharePoint Task topics (created by sending tasks from your map) are cleared of data, but the shell 
topics remain in the map. 

When you open a map that has Secure Save enabled: 

The data in the map is retrieved from SharePoint based on your permissions. 

All data is read from scratch, removing the possibility that you could see data that you don’t have permission to 
view. If the map contains many linked SharePoint tasks, it may take some time for the map topics to fully populate 
with data. 

NOTE: When a map is opened that was not saved in Secure Mode, it will display the previous data 

momentarily, and then refresh based on the user's permissions.  It is possible that a user may get a brief 
glimpse of data they do not have permission to view. 

Edit a map in MindManager desktop 

You can edit your map in MindManager for Windows and save the edited map back to your SharePoint site. 

You must have MindManager installed on your system to use this command. MindManager 8 for Windows, 
MindManager 9 for Windows, MindManager 2012, Mindmanager for Windows version 11, MindManager 14 and 
15  are all supported. If you don't have one of these apps installed, you can use the link in the pop-up message to 
install a free trial. 

NOTE: Your ability to open and edit maps is controlled by your permissions in SharePoint. 

What do you want to do? 

 Open a map in MindManager 

 Edit the map 

 Save the map 
  



Creating and editing maps 

32 

Open a map in MindManager 

HINT: to prevent others from making changes to the map at the same time, you can use the SharePoint 

commands to check out the map. You are not required to check out the map before editing, unless this 
setting is enabled in your SharePoint environment. 

To open a map for editing in MindManager: 

 Point to the map name in the document list, click the down arrow, and then click Edit in MindManager 
desktop. 

o If no user has the map checked out, the map will open for editing. 

o If you have the map checked out, the map will open for editing, and you'll see the checked-out 

indicator at upper left:   . 

o If another user has the map checked out, you can open the map in Read-Only mode, and you'll see 

the read-only indicator at upper left.  

Top of Page 

Edit the map 

Use the commands on the Mindjet desktop ribbon to edit the map. If the map is read-only, you will be able to view, 
but not edit the map. 

For more information on viewing and editing your map, consult the MindManager desktop Help file. 

Top of Page 

Save the map 

When you are finished editing the map, you must save it to commit your changes. 

 Use the Mindjet desktop Save command to save your changes. 

If you have the map checked out, you will be prompted to check it back in to upload the changes to SharePoint. 
Once it is checked in, other users will see your changes, and they will be able to edit the map. 

See also: 

View or edit a map in the browser 
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Using the Mindjet Viewer Web Part 

Insert the Web Part on a page 

You can use the Mindjet Viewer Web Part to display a map on a SharePoint page. When you insert this Web Part 
on a page, it displays the map you specify in the Mindjet Viewer. People who view the page can view the map 
interactively, but they cannot edit it. 

What do you want to do? 

 Insert the Web Part on the page 

 Customize the settings and specify the map to display 

 Get Help using Mindjet Viewer 
  

Insert the Web Part on the page 

1. First, copy the url of the map (.mmap file) you want to display using the Web Part: Right-click the map name 
in its document library, and then, in the shortcut menu, click Copy Shortcut. You will use this shortcut in the 

next section. 

2. Create a new page or open an existing page. 

3. On the page's ribbon, click the Page tab, and then click Edit. 

4. On the Editing Tools, Insert tab, click Web Part. 

 

 

5. In the Web Parts Categories list, select Mindjet, and then select the Mindjet Viewer WebPart. 

 

 

6. Click Add. The Web Part appears on the page with the message "No map specified". Continue with the next 
section to customize the settings and specify the map. 

Top of Page 

Customize the settings and specify the map to display 

You can customize the Web Part's settings when you first insert it into a page, or at any time. 
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1. Point to the Web Part title, click the down arrow, and then click Edit Web Part. 

 

2. The Web Part properties pane appears at the right, where you can customize the settings and specify the 
map to display. 

Change the displayed size   

 

In the APPEARANCE group, change the HEIGHT and WIDTH settings to 
display the Web Part at a specific size. 

Specify the map to display   

 

In the MINDJET VIEWER PROPERTIES group paste the URL for the map 
(.mmap file - from step 1 in the previous section) into the MIND MAP 

URL field. 

3. Click APPLY at any time to check the changes you have made, then click OK when you are finished. 

Complete information on configuring other Web Part properties is available from Microsoft at: 
http://technet.microsoft.com/en-us/library/ee329475(office.12).aspx 

Top of Page 

Get Help using Mindjet Viewer 

The Viewer has its own online Help, accessible from the status bar: 

 

http://technet.microsoft.com/en-us/library/ee329475(office.12).aspx
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It contains instructions for using the Viewer commands to interact with the map.  
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For administrators 

Administering your MindManager Server account 

The MindManager Server Administrator's page lets you: 

 Enter an email address for the MindManager Server administrator. 

(This address is presented to users when you have used up all your available user licenses.) 

 Enter a new license key (when you renew or upgrade your license) 

 See information about your current license, including: 

Contract number 

Licenses used and Licenses available 

Installation Date and license Expiration Date 

 See the list of licensed users 

 Assign licenses to specific users for guaranteed access 

To see this page: 

1. Navigate to your SharePoint Central Administration page. 

2. Click the Manage MindManager Server Settings link. 

Licensed users 

Users' access to the MindManager Server commands for creating and editing maps depends on their SharePoint 
permissions. When a user saves a map, they are automatically counted as a licensed user under your 
MindManager Server contract. 

 To see all licensed users, expand the Licensed Users group on the MindManager Server Administration 

page. 

If you have reached the limit of licensed users, additional users will still be able to access the MindManager Server 
commands, in accordance with their SharePoint permissions, but they will receive a message to contact the 
MindManager Server administrator at the address displayed here. 

You can Assign user licenses to specific users to reserve licenses for their exclusive use and guarantee them 
access. 

The two check-boxes under Notifications and Reminders control whether emails will be sent on subscription 

expiration (about to expire or already expired) and when all seat licenses have been used. Both are checked by 
default. 

To add more users to your MindManager Server license, contact Mindjet. You will be provided with a new license 
key that you can enter here. 

Enable and add Mindjet map templates 

When a user clicks the New Map button from the Documents toolbar they will be able to create a new blank map or 

create a map based on one of the existing templates. To enable the existing templates so they are visible to the 
user: 

1. Choose Site Settings 

2. Selecting Site collection features 

3. Activate MindManager Map Templates 

If MindManager Map Templates are deactivated a user will still be able to create a blank map. 

Custom templates can be added by using the MindManager desktop product to create them and uploading the 
template and thumbnail image to the MindManager Templates library in the root site collection. 
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Disable MindManager features for specific site collections 

When MindManager Server is installed it automatically enables the ability to add a New Map from the Library using 
a button on the Library Tools Documents tab. It also adds the MindManager menu options in the file drop down 
menu. These features are enabled on a site collection level and unless specified are enabled for all site collections 
in the SharePoint farm. 

In scenarios, where users will not be using Mindjet, SharePoint site collection administrators have the ability to 
disable these features for specified site collections. 

What features can I disable? 

The following features can be disabled from specified site collections: 

1. The New Map button in the ribbon Documents tab will be removed. 

 

 

2. The MindManager viewing and editing options in the Library item's drop-down menu will be removed. 
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3. The Mindjet Viewer Web Part will not be available for adding to pages using the page editing tools: 
 

 

How do I disable these features? 

1. Navigate to the Site Collection where you want to disable the MindManager features. 

2. Log in as the site collection administrator. 

3. Under Site Actions, click Site Settings. 

4. On the Site Settings page, under Site Collection Administration, click Site collection features. 

 

5. Click Deactivate for MindManager Map Templates and Mindjet Viewer Web Part.

 

How do I confirm that the features are disabled? 

You can confirm that the features listed above under What features can I disable? are removed by doing the 
following: 

 Navigate to a Site in this Site Collection and then to a Shared Document library on that site. 

o On the ribbon's Documents tab confirm that the New Map button is removed. 

o If the library contains a MindManager map file, click the file drop-down to confirm that the 
MindManager options are removed from the menu. 
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 Open an existing page on the site. 

o On the page's ribbon, click the Page tab, and then click Edit. on the Editing Tools ribbon Insert tab, 
click Web Part. MindManager will no longer be listed under Categories. 

 In some instances, Site Collection administrators may see that the Mindjet Viewer Web Part is 
still available for insertion into a site. 

To remove this option: 

1. Under Site Actions, click Site Settings. 

2. Under Galleries, click Web parts. 

3. Select the ConnectSP.webpart and delete it. 

  

Assign user licenses to specific users 

By default, MindManager Server user licenses are "pooled" and assigned to site users on an as-needed basis, in 
first-come first-served order. If all the available licenses are being used, additional users will be denied access to 
MindManager features. 

If you want to reserve licenses for particular site users or groups so that they always have access, you can “lock” 
licenses by assigning them to a specific user or to a user group. The licenses you assign are available only to these 
users, and they are deducted from the number of "pooled" licenses available to the remaining site users. 

Assign user licenses to specific users 

1. On the Central Administration page, under MindManager Server Administration click Manage MindManager 
Server settings. 

2. On the MindManager Server Administration page, under Current License, you will see the number of 
Licenses used (number of licenses assigned to specific users) and Licenses available (number of "pooled" 
licenses available to all site users). 

3. Under Licensed Users use the Add new users(s) or groups(s) field to assign users. There are two ways to 
select users: 

 Enter each user's name, then click  (check names button) to reconcile each user name with the 
list of site users. 

 Click    to search for and select people and groups of site users.    

4. When you have added the new users or groups, click Confirm Users. Select the users or groups you want 

to assign licenses to. Users who are not selected will not be assigned licenses. 
 
The users you added will now be displayed in the Licensed Users list. 

NOTE: If you attempt to assign licenses to a list of individual users whose number exceeds the 

Licenses available number, or to a Group whose user count is greater than Licenses available 
number, licenses will be assigned in order to users or group members up to that number. 
 
EXAMPLE: under Current License, the Licenses available is 20.  You add 30 individual users or a 
group with 30 users.  Only the first 20 users of the 30 will be assigned licenses. 

5. Click Save. 

The next time you visit the MindManager Server Administration page, you will see the Current License information 
on the page updated to reflect the actual Licenses used (number of licenses assigned to specific users) and 
Licenses available (number of "pooled" licenses available to all site users). 

Remove license assignments 

1. On the Central Administration page, under MindManager Server Administration click Manage MindManager 
Server settings. 
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2. On the MindManager Server Administration page, under Licensed Users, select the check box in the 
Remove column for each user you want to remove. [To remove all users, select the Remove (all) check box 
at the top of the column.] 
 
The users you removed will be crossed out in the user list, and their licenses will return to the pool of 
available licenses. 

3. Click Save. 

The next time you visit the MindManager Server Administration page, you will see the Current License information 
on the page updated to reflect the actual Licenses used (number of licenses assigned to specific users) and 
Licenses available (number of "pooled" licenses available to all site users). 
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Copyrights 

All content © 1994 - 2014 Mindjet. 

Mindjet, MindManager Server, and MindManager are registered trademarks of Mindjet in the United States and 
other countries.  Microsoft and SharePoint are registered trademarks of Microsoft Corporation in the United States 
and other countries. 

  

 


